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Basic Printing

Basic Printing

Note @ This Quick Start Guide describes some of the features of your i350/
i250 printer and how to use them. For more information, view the
i350/i250 User's Guide on the Setup Software & User's Guide CD-
ROM, or use the online help within your printer driver interface:

‘Windows|

While in the printer's Properties window, press the F1 key, or click ? in
the upper right corner. Then click the feature you want to know more
about, or click the Help button when displayed.

Turn Balloon Help on by selecting Help, then Show Balloon Help.

® The diagrams and computer screens in this guide refer to the i350.
The operations are exactly the same with the i250.

Turning on the Printer

1 Press the POWER button.

The POWER lamp flashes while the printer warms up and changes to steady (non-
flashing) green when the printer is ready.

Important ® Before unplugging the power cord, turn off the printer and
ensure that the green lamp has gone out.
® |f the POWER lamp changes to orange and begins flashing,
refer to the section "Handling Error Messages" on page 46.
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Loading Paper

B Print Media to Avoid

Do not use the following types of paper. Using such paper will not only produce
unsatisfactory results, but can also cause the printer to jam or malfunction.

1

Folded, curled or wrinkled paper

Damp paper

Excessively thin paper (less than 64 gsm or 17 lb)
Excessively thick paper* (more than 105 gsm or 28 |b)
*non-Canon branded paper

Picture postcards

Postcards affixed with photos or stickers
Envelopes with double flaps

Sealed envelopes

Envelopes with an embossed or treated surface
Any type of paper with holes (such as loose-leaf)

Loading the Print Media

In this section, description for loading Plain Paper into the printer is given as an
example.

e Consult the User’s Guidefor detailed instructions on how to load envelopes and

For detailed information on the specialty media Canon provides for use with its

various printers, refer to the section "Using Specialty Media" on page 6.
specialty media into the printer.

Flatten the four corners of the paper before loading it.

Important When paper is curled, gently bend them in the opposite direction until

the paper becomes completely flat.
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2 Prepare to load paper.

(1) Open and pull out the paper rest
(fori350 only).

(2) Pull out the paper output tray
(fori350 only).

3 Load the paper.

Limit Mark
Do not load beyond this Load Limit Mark.

(1) Insert the paper in the sheet feeder
with the print side facing up.

(2) Align the paper stack snug against
the right side of the sheet feeder.

(3) Pinch the paper guide and slide it against
the left side of the stack of paper.

Note @ Do not stack more than 50 sheets in the paper output tray.
g8
® Do not touch the printed surfaces until the ink dries. For specific
drying times, refer to the instructions packaged with your media.
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Using Specialty Media

Canon recommends that you use genuine Canon media to ensure optimal print quality.

B Photo Quality Media B Media Suited for Business
e Photo Paper Pro Documents
¢ Photo Paper Plus Glossy e High Resolution Paper
¢ Matte Photo Paper e Transparencies

Glossy Photo Paper
High Resolution Paper

Ir:
Innovation

Anmunl Report | 75
.,o o s
I i ech hetwork

‘"‘.‘éﬁx.—s_ ]

B Canon Specialty Media

Media Type Paper Rest Load Limit Printer Driver Setting
Media Type
Photo Paper Pro Letter: 10 sheets Photo Paper Pro*
4” x 6” : up to 20 sheets
Photo Paper Plus Glossy Letter: up to 10 sheets Photo Paper Plus Glossy

5” x 7” : up to 10 sheets
4” x 6” : up to 20 sheets

Matte Photo Paper Up to 10 sheets Matte Photo Paper
Glossy Photo Paper Up to 10 sheets Glossy Photo Paper
High Resolution Paper Up to 80 sheets High Resolution Paper
T-Shirt Transfers 1 sheet T-Shirt Transfer
Transparencies Up to 30 sheets Transparency
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Note ® When using plain paper, up to 100 sheets can be set. Select Plain Paper

from the printer driver Media Type.

® For detailed description of print media types, refer to the User’s Guide.

® *:When loading Letter-sized paper to the auto sheet feeder, do not load the
paper all at once. To avoid sticking, load the necessary number of paper (up
to 10 sheets) one at a time.
Print settings are much easier to select if you use the applications included
on the Setup Software & User’s Guide CD-ROMwhen printing on the Photo
Paper Pro.

Windows
Printing with Windows

Note ® The menu screens and dialog boxes that appear may vary, depending on the
software application you are using.
® The steps described in this section are for printing in Windows XP.

1 Create a documentor open a file to print.

2 Open Printer Properties dialog box.

(1) Select Print from the application software's File menu.

Select Printer

1= (2) Ensure that Canon i350/
add Printer  [EERTWEE i250 is Selected.
s Dp.mw— (3) Click Prgferences or
Comment Properties.
Page Range
@ a0 Mumber of copies: |1 3
LRI

Note InWindows 2000, click the Main tab in the Print dialog box.
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3 Specify the required settings.

& Pprinting Preferences

E[ES)
) Main | &5 Page Setup| @] Stamp/Background || ## Effects | [ Proflss| i} Maintsnance:
. .
- h— (1) Click Media Type to select
Paper Souce: Eito Sheet Feeder ~ the type Of media loaded in
Print Bualiy: O High .
5 Standard R
g the printer
Og;slum
Color Adiustment. @ Auto
O Manual
(] Gragscale Printing
[ Preview before piinting
L (2) Click OK.

Note @
°
°
°

From the Page Setup tab, select the correct document size to be
printed.

To adjust Print Quality settings, select Custom and click Set on the
Main tab. You can control quality in the Set Print Quality dialog box.
For details about other printer driver functions, refer to the User’s
Guideor Help.

Select Preview before printing by clicking the check box. This
displays a preview screen that allows you to confirm the selected
printing effects and how your document will look when printed.
Some applications do not contain the function to display the
preview.

4 Print the document.

General
Select Printer
Add Printer

Stalus:  Ready

Lacation:
Comment:

Page Fiange

@al

[ Print ta file

Mumber of gopies: |1 %
el
(1) Click Print.

Note You can cancel a print job in progress by simply pressing the RESUME/
CANCEL button on the printer.
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Printing with Macintosh

Note ® The menu screens and dialog boxes that appear may vary, depending on the
software application you are using.
® The steps described in this section are for printing in Mac 0S 9.

1

Create a document or open a file to print.

2 Select Paper Size.

(1) Select the Page Setup from the application software's File menu.

(2) Select the desired paper

Canoni3so Version 4.4
0K
~
paperSiz§ : [Letter B);
Cancel
[J Borderless Printing
- Amount of Extension :
% Mi, ey Ma,
scale:  [100 2] %
Orientation :
Height:2704mm  Width:215.0mm . -
[ Save Settings
(3) Click OK.

Specify the required settings.

size from the Paper Size
pull-down menu.

(1) Select Print from the application software's File menu.

Canon i350

:

Version 4.4
e El __Cﬂm:el
Pages: @ Al -
ofem [ |Te [ ]

BJ Cartridge :
[calor

Media Type :

Plain Paper

(
e

Auto Feeder

B

— (2) Select the Media Type from
the pull-down menu.

L (3) Selectthetype ofdocument

from the Print Mode pull-

(4) Click Print.

down menu.
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10

Note @ When you select the type of document from the Print Mode pull-
down menu, the document will be printed in color and print quality
suited to the characteristics of Media Type you have selected.

Text:

Graphic:

Photo:

Manual:

Select when printing documents consisting mainly of
text.

Select when printing documents consisting mainly of
graphs and graphics (illustrations) with strong color
definition.

Select when printing documents consisting mainly of
photographs and graphics featuring fine color
gradation.

If you select Manual, the Details button will become
selectable. Click the Details button to display the
Detailed Setting dialog box where you can fine-tune the
Print Quality and Halftoning settings.

Refer to the User’s Guide.

For details about other printer driver functions, refer to the User’s
Guide or Help.

® You can cancel a print job in progress by simply pressing the
RESUME/CANCEL button on the printer.
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Advanced Printing

Accessing Printer Driver

The Printer Properties dialog box can be opened from either within an
application, or directly from the Windows Start menu.

Note @ This manual refers to Windows XP operation.
The operations may vary depending on your operating system.
® Depending on your application program, the command and menu names
may differ, and there may be more steps involved in opening the Printer
Properties dialog box. For more details, see the user's manual for your
application.

B Opening the Printer Properties Dialog Box from Your Application
Program
1 in your application, select the command to print a document.

The Print dialog box can usually be opened by selecting Print from the File menu.

2 Ensure that Canon i350/i250 is selected. Then click Preferences (or
Properties).
The Printer Properties dialog box opens.

B Opening the Printer Properties Dialog Box Directly from the Start
Menu

This method is used for maintenance operations such as print head cleaning, or to
specify printer settings common to all application programs.

When the Printer Properties dialog box is opened from the Start menu, additional tabs
appear, including the Details tab. These do not appear when the Printer Properties
dialog box is opened from within an application.

For more information about these additional tabs, refer to your Windows
documentation.

1 Click Start and select Control Panel, Printers and Other Hardware, and then
Printers and Faxes.

For other Windows versions, click Start, select Settings, and then Printers.

2 Select the Canon i350/i250 icon.

11
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3 Open the File menu and select Printing Preferences (or Properties).

The Printer Properties dialog box opens.

Adjusting Print Quality for Photographs

B Improving the Quality of Printed Images

Two important factors control the quality and output of your printed images:

Paper and Ink

Using recommended Canon paper, specialty media, and inks for printing
photographs can significantly improve the quality of your printouts. See the inside
back cover for a list of Canon media and inks for this printer.

Printer Driver Settings

The printer driver has a variety of settings that can be used to creatively enhance the
colors and output of your photographs. Many of these features are covered in this
chapter.

For more detailed information, see the i350/i250 User's Guide on the Setup Software &
User's Guide CD-ROM.

You can also access the online help in either of the following ways depending on your
operating system:

(Windows|

e Press the F1 key.
e (Click ? in the upper right corner, then click the feature you want to know more about.
e (Click the Help button when displayed.

e Turn on Balloon Help by clicking Help, then Show Balloons.

B Adjusting Print Quality

12

Features that affect the appearance and quality of your printed images can be
controlled with the printer driver.

The i350/i250 automatically adjusts printer settings to improve print quality based on
the media type (plain paper, Photo Paper Pro, and so on). You can also customize the
Print Quality settings if desired.
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To manually adjust Print Quality settings:

(Windows|

1

Open the Printer Properties dialog box.

See"Opening the Printer Properties Dialog Box from Your Application Program"
on page 11.

Select Custom in Print Quality, then click Set... to open the Set Print
Quality dialog box.

Move the slide bar to adjust the print quality.
Sapimouatty 2%

] 4 3 2

Gl Standard 3 I Ji@
Fast

Fine.
e W @
Auto

Dither Diffusion

[ Eieduce spool data size

ok | [ tencel J[ He

When the process is complete, click OK.

Open the Print dialog box.

See "Printing with Macintosh" on page 9.

Click Print Mode and select Manual, then click Details... to open the
Detailed Setting dialog box.

Move the slide bar to adjust the print quality.

Canon Detailed Setting

Print Quality: Fast e====fi=—— Fine

Normal (Fine)

Halftoming
Diffusion
|| [[Restore Defauits

When the process is complete, click OK.

13
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To automatically optimize the image:

Photo Optimizer PRO automatically adjusts the photographic image created with a digital
camera. Use this feature to compensate for unsatisfactory color balance and over- or
under-exposure before printing.

(Windows|

1

S WN

S~ NN R

14

Open the Printer Properties dialog box.

See"Opening the Printer Properties Dialog Box from Your Application Program"
on page 11.

Click the Effects tab.
Select the Photo Optimizer PRO check box.

& Canon i350 Printing Preferences,

Click OK.

Open the Print dialog box.
See "Printing with Macintosh" on page 9.

Click Print Mode and select Manual, then click Details... to open the
Detailed Setting dialog box.

Click & (Special effects).
Select the Photo Optimizer PRO check box.

Canon Detailed Setting
[ simulate illustration
=] Contrast: gy
Quaity
Speoial erfects
&
ccccc
Restore Defaults
.

Click OK.
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To use Vivid Photo option:

Vivid Photo intensifies background colors like fields, trees, oceans and skies, while
maintaining natural skin tones in the images.

Note InWindows Me or Windows 98
If Background Printing has been disabled, the Vivid Photo function is
not available.

(Windows|

To use Vivid Photo, select the Vivid Photo check box on the Effects tab.

& Canon i350 Printing Preferences PRIl
& Man|| S Page Setup | B | ## Effeets | £ Profies | fi} Maintenance

[ Simulate lustiation

[ Monochiome Effects:

(’wm Pnnm)
[JPhoto Noise Reduction
ok J [ concel ][ gy ][ Hep

To use Vivid Photo, select the Vivid Photo check box under Special Effects.

Canon Detailed Setting

[ simulate illustration

Contrast: e

[ Menochrome effects :
Color: = [

[A Vivid Phu(D

[ Photo Optimizer PRO
[ Apply Throughout Page
[ Pnoto Noise Reduction

Normal ¥
i =3

15
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To reduce noise from images taken with a digital camera:

Photo Noise Reduction function reduces noise from blue portions, such as the sky
and dark portions of the images taken with your digital camera.

Note In Windows Me or Windows 98

If Background Printing has been disabled, the Photo Noise Reduction
function is not available.

(Windows|

To use Photo Noise Reduction, select the Photo Noise Reduction check box on the
Effects tab.

& Canon i350 Printing Preferences,

| S5 Main | & Poge Selup| @) Stamp/Background | ## Effects | (5] Profies | i} Maintenance|

[ simu fion

] Monochiome Effects:

‘ [Jivid Photo

[#™ " [Jimage Optirizer

1 ] Photo Optimizer

: < EI [Z1Phots Naise Reductior; 1@%;{"' —

‘

o[ == 7][ 7ADDIy’ 7]i H;\D ]

To use Photo Noise Reduction, select the Photo Noise Reduction check box under
Special Effects.

Canon Detailed Setting

[ simulate illustration

]
peeres) Contrast: e
vy ?
[ Monochrome eftects
Color:  Qr————
Special effects. .
ﬁ; [ Vivid Photo
=

[0 Photo Optimizer PRO
[ Apply Throughout Page
& Photo Noise Reduction :

=3

Color

DT

16
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B Saving and Recalling Driver Settings

When you change printer driver settings for a specific print job, such as printing black
and white photos, or printing documents with a special background, you can save and
name these settings for future use on similar print jobs.

(Windows|

1

N

(9 )

Open the Printer Properties dialog box.

See "Opening the Printer Properties Dialog Box from Your Application
Program" on page 11.

Click the Profiles tab.

Enter the new settings in Profiles.

— (1) Click Add to Profiles.

)

The Add to Profiles dialog box opens.

TR ——— ]
— (2) Enterthe name of profile for

('5 @589 3 registering settings.
o L_L (3) Select an icon.

—1 (4) Enter a description on the
registering profile.

Click OK.

Click OK on the Profiles tab.
This registers your printer driver print settings.

Note You can retrieve or delete the print settings profile at any time.
Retrieving profile: Select the desired profile from Printing
Profiles, and click Retrieve from Profiles.

Deleting unwanted profile: Select the desired profile from
Printing Profiles, and click Delete.
For details, click Help and refer to the topic of this function.

17
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1 oOpen the Print dialog box.

See "Printing with Macintosh" on page 9.

2 Click Apply.
The Register Settings dialog box opens.

3 Enter the print settings to register.

Canon Register Settings

Settings :
Factory Defaults

[T

) o (Qame }— (1) Click Apply...
(it |

The New Settings Name screen opens.

MNew Settings Name :
Unknown —H— (2) Enter a name under which
cancel | [ ok || to register your settings.
4 click ok

5 Click Close in the Register Settings dialog box.

This registers your printer driver print settings.

Note You can retrieve or delete the saved driver settings at any time.

Retrieving print settings: Select the name of the settings to
retrieve from the Settings list and click Import.

Deleting unwanted drivers settings: Select the name of the
settings to delete from the Settings list and click Remove.

18
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Using Printer Driver Options

Your printer driver will provide you with many features that allow you to print a wide range of
images and documents.
The illustrations below provide a basic introduction to many of these.

Note For detailed descriptions of the printer driver functions, refer to the User’s
Guideincluded in the Setup Software & User's Guide CD-ROM.

Printing with Borderless Printing (i350 only) Reducing Noise from Images Taken with

Digital Camera
6 ., A
L ]

Smoothing the Rough Edges of Certain
Images Page

he 10th Anniversary

estival

F.

Adding lllustrated Effect to Documents
Resizing the Image by Selecting the Scaling

Ratio

19
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Using the Bundled Software

The Setup Software & User’s Guide CD-ROMincludes photo applications designed to edit
the photographs taken by a digital camera and print them as photo-lab quality prints.
Please use the application(s) suitable for your print purposes.

Note Toinstall applications, refer to £asy Setup Instructions.

B Easy-PhotoPrint (Windows/Macintosh)

20

You can print Borderless Photos easily and quickly, just by selecting a photograph
taken with a digital camera and the paper type on which to prmt You can also use
simple editing features such as trimming and image rotation. It is Exif Print (Exif 2. 2)"
compatible.

Easy-WebPrint (Windows)

You can easily print pages displayed on the Internet Explorer or pages from the User’s
Guide (on-screen manual of this printer) in full size. Easy-WebPrint automatically
adjusts the layout when printing a screen. This feature enables you to print a screen
without its right end being cut off.

This application is a plug-in for Internet Explorer, and its toolbar is automatically added
to Internet Explorer after installation. Internet Explorer 5.5 or later must be installed.

*: Exif Print (Exif 2.2) is a new worldwide standard. Under Exif 2.2, the digital camera
can record data tags for specific camera settings and functions such as whether the
flash was on or off, if the camera was in portrait or night scene mode, etc.

BJ Printers support Exif Print and use a suitable photo application to read the
camera data precisely, producing optimal prints. This enables you to create prints
that reproduce your vision more accurately than ever before.
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(Windows|
Printing Photographs with Windows

By using Easy-PhotoPrint supplied with the i350/i250, you can easily print by following the
simple steps outlined here. As well, the i350 can make borderless prints of photographs
taken with a digital camera.

This chapter explains how to make borderless prints with the i350. The i250 also prints
beautiful, high quality photographs using the same steps as the i350, but does not support
Borderless Printing.
Note Media Types Suitable for Borderless Printing
Media types compatible with Borderless Printing include Photo Paper
Plus Glossy (4” x 6”, 5” x 7”) and Photo Paper Pro (4” x 6”).

1 start Easy-PhotoPrint.
This section describes how to print photographs stored in the folder on the hard
disk.
(1) Store the photographs you took with your digital camera in the folder on the
hard disk.

(2) Click Start, select All Programs (or Programs), Canon Utilities, Easy-PhotoPrint,
and then Easy-PhotoPrint.
The 1.Image Selection tab is displayed.

2 Select photographs.

(1) Select the folder containing the photograph you want to print.
All photographs in the selected folder are displayed.

Guidance

|

Thumbnail

Folder window

21
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(2) Click the [+] button on the thumbnail of the photograph you want to print and
specify the number of copies.

At

Increases the number of copies.

Displays the specified number of copies.

Decreases the number of copies.

(1) Click the 2. Paper
Selection tab.

(2) Select the size of the
paper you use from
Paper Size.

(3) Select the type of the
paper you use from

Media Type.

(1) Click the 3. Layout/
‘‘‘‘‘‘ < ) Print tab.

(2) Select Borderless (full).

Sice ;46 Medla Type : Phcta Paper ro 4 Page(s) A

(3) Load the media specified in the 2. Paper Selection tab.
(4) Click Print.

22
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Printing Photographs with Macintosh

By using Easy-PhotoPrint supplied with the i350/i250, you can easily print by following the
simple steps outlined here. As well, the i350 can make borderless prints of photographs
taken with a digital camera.

This chapter explains how to make borderless prints with the i350. The i250 also prints
beautiful, high quality photographs using the same steps as the i350, but does not support
Borderless Printing.

Note Media Types Suitable for Borderless Printing

Media types compatible with Borderless Printing include Photo Paper
Plus Glossy (4” x 6”, 5” x 7”) and Photo Paper Pro (4” x 6”).

1 start Easy-PhotoPrint.

This section describes how to print photographs stored in the folder on the hard
disk.

(1) Store the photographs you took with your digital camera in the folder on the
hard disk.

(2) Open the Easy-PhotoPrint folder, and double-click the Easy-PhotoPrint icon in
the folder.

2 Select photographs.

(1) Select the folder containing the photograph you want to print.
All photographs in the selected folder are displayed.

Easy-PhotoPrint

Guidance

Thumbnail

Folder window

(2) Click the [+] button on the thumbnail of the photograph you want to print and
specify the number of copies.

23
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— |ncreases the number of copies.

Displays the specified number of copies.

Decreases the number of copies.

3 Select the paper.

(1) Clickthe 2. Paper Selection
= @ tab.

[ Photo Noise Reduction :

— (2) Select the size of the paper
you use from Paper Size.

— (3) Select the type of the paper
you use from Media Type.

(1) Click the 3. Layout/
Print tab.

(2) Select Borderless (full).

(3) Load the media specified in the 2. Paper Selection tab.
(4) Click Print.

24
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Printing Maintenance

When Printing Becomes Faint or Colors are Incorrect

When printing becomes faint or colors are incorrect, even if ink remains in the
ink tanks, the print head nozzles are probably clogged. Follow the
procedures below to clean the nozzles.

Step 1
‘ "Printing the Nozzle Check Pattern" on page 26 ’

If the problem remains If white stripes are noticeable

. .

Step 2 Step 2
‘ "Print Head Cleaning" on page 28 ’ ‘ "Aligning the Print Head" on page 33 ’

If the problem remains

-

Step 3

‘ "Print Head Deep Cleaning" on page 30 ’

If the problem still remains

-

Step 4
‘ "Replacing an Ink Tank" on page 36 ’

Note @ Ifinktank replacement does not resolve the problem, contact the Customer
Care Center.
® You will be alerted if low ink warning is enabled.

25
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Printing the Nozzle Check Pattern

Print the nozzle check pattern to determine whether the ink ejects properly from the print
head nozzles, and to verify print head alignment. Use this function when printed results are
blurred or the color is incorrect.

(Windows|

With the printer on, load a sheet of Letter-sized paper in the printer.

2 Open the Printer Properties dialog box.

See "Opening the Printer Properties Dialog Box Directly from the Start Menu" on
page 11.

3 Print the Nozzle Check Pattern.

& Canon i350 Printing Preferences

) Main| 3 Page Setup | @) Stamp/Backgiound | o Effects | (3 Prdfiles| #4 M — (1) Click the Maintenance tab.

E‘ (2) Click Nozzle Check.

ok [ Cancel [ gk | [ Hep ]

(3) When the confirmation message is displayed, click OK.
See "Examining the Nozzle Check Pattern" on page 27.

26
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With the printer on, load a sheet of Letter-sized paper in the printer.
Open the Printer Utility dialog box.

N =

(1) Select Page Setup... in the File menu.
(2) Click Utilities... to open the Printer Utility dialog box.
3 Print the Nozzle Check Pattern.

Canon i350 Printer Utility Version 4.4
- Gestprint =) (1) Select Test Print from the
Nozzle Check pull-down menu.
Prints a nozzle-check pattern.

(2) Click Nozzle Check.

@ Print Head Alignment
It will align the print heads to correct any

error in their installation position.

Coes= )

(3) When the confirmation message is displayed, click OK.

See "Examining the Nozzle Check Pattern" on page 27.

B Examining the Nozzle Check Pattern

The nozzle check pattern should appear as follows when ink is discharged properly.
Examine the nozzle check pattern output by the printer.

(1) Lines missing here indicates that the print
head requires cleaning.

See "Print Head Cleaning" on page 28.
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Print Head Cleaning

Clean the print head if you suspect that the nozzles might be clogged. Cleaning the print
head consumes ink, so perform print head cleaning only when necessary.

(Windows|

Ensure that the printer is on.

2 Open the Printer Properties dialog box.

See "Opening the Printer Properties Dialog Box Directly from the Start Menu" on
page 11.

3 Start Print Head Cleaning.

& Ganon i350 Printing Preferences

1) Main| 2 Page Setup | @) Stamp/Background | e Effects | (3 Prefjes| B Mairtenance (1) Click the
Y <@ - Maintenance tab.
Cleaning : Deep Cleaning Raller Cleaning
W | 6 |
oy (2) Click Cleaning.

ok | [ cencel J[ ey ][ Hep

(3) When the confirmation message is displayed, click OK.

Important Do not perform any other operations until the print head
cleaning finishes. This takes about 60 seconds.

Note @ After print head cleaning finishes, print the nozzle check pattern to
verify that the print head nozzles are clean.

See "Printing the Nozzle Check Pattern" on page 26.
® If the problem persists, perform print head deep cleaning.
See "Print Head Deep Cleaning" on page 30.
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Ensure that the printer is on.

2 Open the Printer Utility dialog box.

(1) Select Page Setup... in the File menu.
(2) Click Utilities... to open the Printer Utility dialog box.

3 Start Print Head Cleaning.

‘Canon i350 Printer Utility Version 4.4
—([CIeaning iD (1) Select cleaning
eanin fl’0m the pull'
“ Stﬂl'tsgprint-head cleaning. dOWn menu.

“ Deep Cleaning
Starts print-head deep cleaning.

Roller Cleaning
Starts cleaning paper feed rollers.

I— (2) Click Cleaning.

(3) When the confirmation message is displayed, click OK.

Important Do not perform any other operations until the print head
cleaning finishes. This takes about 60 seconds.

Note @ After print head cleaning finishes, print the nozzle check pattern to
verify that the print head nozzles are clean.

See "Printing the Nozzle Check Pattern" on page 26.
® If the problem persists, perform print head deep cleaning.
See "Print Head Deep Cleaning" on page 30.
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Print Head Deep Cleaning

If print quality does not improve by standard print head cleaning, try performing a print
head deep cleaning, which is a more powerful process. Print head deep cleaning consumes
more ink than standard print head cleaning, so perform this procedure only when
necessary.

(Windows|

Ensure that the printer is on.

2 Open the Printer Properties dialog box.

See "Opening the Printer Properties Dialog Box Directly from the Start Menu" on
page 11.

3 Start Print Head Deep Cleaning.

aaaaaaaaa — (1) Click the Maintenace tab.

0 E (2) Click Deep Cleaning.

Q5 Stan Stous Monto,

ok | [ concel [ amy [ wep |

(3) When the confirmation message is displayed, click OK.

Important The process takes about one minute to complete, so simply
wait until the POWER lamp stops flashing.
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Note @ After print head deep cleaning finishes, print the nozzle check
pattern to verify that the print head nozzles are clean.

See "Printing the Nozzle Check Pattern" on page 26.

® If the head is still not clean after the second deep cleaning, replace

the ink tank.

See "Replacing an Ink Tank" on page 36.

® Ifinktank replacement does not resolve the problem, the print head
may be worn out. Contact the Customer Care Center.

Ensure that the printer is on.

Open the Printer Utility dialog box.

(1) Select Page Setup... in the File menu.

(2) Click Utilities... to open the Printer Utility dialog box.

Start Print Head Deep Cleaning.

‘Canon i350 Printer Utility

Version 4.4

4([ Cleaning i])

Cleaning
Starts print=head cleaning.

%]

(8)

Deep Cleaning
arts print-nead deep cleaning.

Roller Cleaning
Starts cleaning paper feed rollers.

I

CooseJ

(1) Select Cleaning from the
pull-down menu.

(2) Click Deep Cleaning.

(3) When the confirmation message is displayed, click OK.

Important The process takes about one minute to complete, so simply
wait until the POWER lamp stops flashing.
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32

Note @ After print head deep cleaning finishes, print the nozzle check
pattern to verify that the print head nozzles are clean.

See "Printing the Nozzle Check Pattern" on page 26.

® If the head is still not clean after the second deep cleaning, replace
the ink tank.

See "Replacing an Ink Tank" on page 36.

® Ifinktank replacement does not resolve the problem, the print head
may be worn out. Contact the Customer Care Center.
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Aligning the Print Head

Aligning the print head position allows you to print without shifts in the color registration.

(Windows|

With the printer on, load a sheet of Letter-sized paper in the printer.
2 Open the Printer Properties dialog box.
See "Opening the Printer Properties Dialog Box Directly from the Start Menu" on

page 11.

3 Print the pattern.

& CGanon i350 Printing Preferences

——— (1) Click the Maintenance tab.

(2) Click Print Head Alignment.

Ik Counter Reset LowIrk Warming Custarn Selings Quiet Mode
Satting

| D5 St Status Montor,

Co ) (oo Lo I )

Canon i350 5]

[\ S b b ’7 (3) When the confirmation message

and prinker power on) and load

is displayed, click OK.

Since printing,
sheet of paper in the sheek Feeder, Head alignment patterns vill be printed,
Start print head alignment?

[T‘Hﬁ

-4

Canon i350

@ Didthe pattsm print successfully?
&/

If nothing was printed, or if the pattern s noticeably faint or patehy, cick o and try again.

) == (4) After the pattern is printed, click Yes.
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4 Align the Print Head.

(1) Look at the print out. Select the patterns that have the fewest white stripes and
enter the numbers that correspond to the selected patterns.

Print head alignment is being executed. Referring to the pattems
printed in columns & to F, select the pattern that shows no flaws.

Harizantal A\ignm?l-[—}tu-v-q
— Calurit A o %
= (2) Enter the numbers.
— Colurnn B: 0 |5
[ ]
—] Colurnn C: o %
—
Bi-directional Aligrgment [-5 to 48]
Column D: o %
Calurnn E: 0s
7 Column F: [

[

(3) Click OK.

~\
o
=

"
[

(4) When the confirmation message is displayed, click OK.

With the printer on, load a sheet of Letter-sized paper in the printer.

2 Open the Printer Utility dialog box.
(1) Select Page Setup... in the File menu.
(2) Click Utilities... to open the Printer Utility dialog box.
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Print the pattern.

‘Canon 350 Printer Utility Version 4.4
{Test Print iD (1) Select Test Print from
Nozzle Check the pull-down menu.
Prints a nozzle-check pattern.

Print Head Alignment
It will align the print heads to correct any
errorin their installation position,

(2) Click Print Head Alignment.

Caes )

(3) When the confirmation message is displayed, click OK.
Align the Print Head.

(1) Look at the print out. Select the patterns that have the fewest white stripes and
enter the numbers that correspond to the selected patterns.

Print Head Alignment

Print head alignment is being executed. Referring to the patterns
printed in columns Ato F, select the pattern that shows no flaws.

Adjust sideways(=3~+7,

—)
E Column A:
= Cotumn B (2) Enter the numbers.
él Column C:
— Adjust both ways (-5~+§)
ColumnD:
ColumnE:
ColumnF:
—/
— (3) Click Send.
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Replacing an Ink Tank

When replacing an ink tank, check the model number very carefully.
The printer will not print properly if the wrong ink tank is used, or installed in
the incorrect position.

Black: BCI-24 Black Canon Color: BCI-24 Color Canon

InkTank

BCI-24

InkTank

BCI-24

O >

B Replacing an Ink Tank
When an ink tank runs out of ink, replace it using the following steps.

1  Ensure that the printer is on, and then open the front cover.

The print head holder moves to the center.

2 Remove the empty ink tank.

Color Black

Important @ Handle ink tanks carefully to avoid staining clothing or the
surrounding area.
® Discard empty ink tanks according to the local laws and regulations
regarding disposal of consumables.
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3

Prepare a replacement ink tank.

(1) Unpack a new ink tank and remove the orange protective cap.

Importaﬁt ® Do not re-attach the protective cap once you have removed it.
® Once the protective cap is removed, do not touch the open ink port.
Insert the ink tank.

(1) Insert a new ink tank into a slot.
(2) Push in the tab until the ink tank snaps firmly into place.

Close the front cover.

The print head holder moves to the right.

Note @ To maintain optimal print quality, use an ink tank within six months

of its first use.

® Once anink tank has been used, do not remove it from the printer
and leave it out in the open. This will cause the ink tank to dry out
and the printer may not function properly if it is reinstalled.

® Colorink consumption may occur even when black-and-white or
grayscale printing is specified.
Colorink is consumed in the head cleaning and deep cleaning,
which are necessary to maintain the printer’s capabilities.

® When an ink tank runs out of ink, replace the ink tank with a new one
immediately.
If printing is continued with no ink in the ink tank, a trouble may
occur.
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B Resetting the Ink Counter

38

When an ink tank is replaced, the ink counter must be reset. The low ink warning is
displayed properly only if the ink counter is reset.

Message Prompting Confirmation of Ink Tank Replacement

When the front cover remains open for a certain period of time, the printer will output a
message prompting you to confirm replacement of the ink tank at the start of the next
print job.

Check the message, and click Yes or OK.

When using Windows: When using Macintosh:
Canon i350: - USBOO1 | X | The printer’s front cover was opened after the last
— printing. Have you replaced an ink tank with a new
' The printer's front cover was opened after the last printing. one?
H Have vou replaced an ink tank with a new one? Ifyou have replaced it, click [0K]. If you have not
If you have replaced it, click Yes. replaced it or you are not sure, click [Cancel].

If you have not replaced it or you are nok sure, click Mo,

Select the replaced ink tank, and click OK.

When both black and color ink tanks have been replaced, select both Black and
Color.

If you have not replaced the ink tank with a new one, click Cancel.

When using Windows: When using Macintosh:
Canon i350:- USBOO1 Ink Counter Reset
Selectthe newly replaced ink tank and click the [0K]
Select the newly replaced ink tank and click OK. button.

[ Black Ink Tank

[ilack ink. Tank
[ Calor Ink Tark. [ color Ink Tank

Cancel




Printing Maintenance

Important Mistakenly clicking No or Cancel, instead, will prevent the Ink Low alert
from functioning properly. If this happens, manually reset the ink
counter according to the following procedure.

Resetting the Ink Counter in Printer Properties dialog box:

® When using Windows:

1. Open the Printer Properties dialog box and click the
Maintenance Tab.

2. Click Ink Counter Reset.
3. Select the newly installed ink tank, then click OK.

® When using Macintosh:
1. Open the Page Setup dialog box.

2. Click Utilities... and select Low Ink Warning Setting.
3. Click Ink Counter Reset.
4. Select the newly installed ink tank, then click OK.

B How Low Ink Warning Setting Works

The low ink warning notifies you of low ink levels during printing. The Low Ink Warning
has been preset to be automatically displayed.

When you reset the ink counter, it will assume that the ink tank is full regardless of how
much ink actually remains. The reset is the only way to match the counter value with an
actual ink volume. Reset the ink counter when installing a new ink tank.

Low Ink Warning Display

The '!" shows a low ink level in the ink tank.

BJ Status Monitor (Windows) B) Status Dialog (Macintosh)

(i) Ganon 1350 - USBOO1

Canon i350 Version 44

“s%)

m T The color ink becomes low.

Piinting Pages. 142

| Cancel Printing | | Display Print Gueue
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How to Display Low Ink Warning Correctly
¢ Reset the ink counter every time you install a new ink tank.

The ink counter cannot work correctly unless you synchronize it with the actual ink
level. The ink counter can be reset only when a new ink tank is installed.

¢ Do not reset the ink counter of an ink tank in use.

Synchronization of the counter and the actual ink level will not work properly.

Important

If you did not reset the counter when you installed the current ink tanks,
the low ink warning may not function correctly, until the next time you
replace the ink tanks. Also, be sure to treat both counters separately.
Refer to "Low Ink Warning Accompanied by Ink Tank Icon With '?'" on
page 49.
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Troubleshooting

This section provides troubleshooting tips for the most common printing problems.
Troubleshooting usually falls into one of the following categories.

¢ "Cannot Install the Printer Driver" on page 42

e "Print Quality is Poor or Contains Errors" on page 43

¢ "Troubleshooting Printer Hardware" on page 44

¢ "Paper Does Not Feed Properly" on page 45

¢ "Handling Error Messages" on page 46

¢ "An Error Message Appears on the Screen" on page 47
Refer to the User's Guide for additional information on topics not covered in this section.

Note

If you encounter any problem during installation or operation of your
printer, quickly scan all topics to find a solution. If the problem persists,
contact the Customer Care Center at (757) 413-2848. See "Canon offers
a full range of customer technical support options" on page 59. ATDD
service (telephone device for the deaf) is also available at (866) 251-
3752.

'Windows|

When an Error Occurs

The BJ Status Monitor opens and displays a message. Take the
appropriate action described in the message.

The message may vary depending on your operating system.

O canon i350 - USB0O1
Option  Help

Printer Status

Paper out
- |Load paper and press piinter's RESUME
* |button.
|

Oreer anan
Document Name:  Untitied - Notepad
Piinling Pages: 1.1

Cancel Frinting | | Display Print Queve

® When using Windows Me or Windows 98, click the Guide tab and
follow the on-screen instructions.
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Cannot Install the Printer Driver

Problem

CannotInstallthe
Printer Driver

‘ Possible Cause ‘

Installation
procedure not
followed correctly

Try This
Follow @he installation instructions for the £asy Setup Instructions packaged with
your printer.
‘W,
If the installer was forced to be terminated due to an error, remove the CD-ROM

from the CD-ROM drive and restart your computer. Reinstall the printer driver. If
this problem persists, contact the Customer Care Cener.

Other applications
running in the
background

Other applications opened on your computer can interfere with the installation
routine. Close all open software applications before reinstalling the printer driver.
Refer to the £asy Setup Instructions for installing the printer driver.

Installation does
not start
automatically when
the CD-ROM is
inserted into the
drive

o
If printer driver installation did not start automatically when you inserted the CD-
ROM into the CD-ROM drive:

1. Click Start and select My Computer.
2. Double-click the CD-ROM icon.

For non-XP Windows, open the My Computer window, and then double-click the
CD-ROMicon.

Double-click the CD-ROM icon on your desktop to start installation.

Installation CD-
ROM not working

properly

Confirm that there are no problems with the Setup Software & User’s Guide CD-
ROM.

W
Use Windows Explorer to confirm that the CD-ROM can be read.

Confirm that the CD-ROM icon is displayed on the desktop.
If there is any problem with the CD-ROM, contact the Customer Care Center.

Unable to proceed
beyond the Printer
Port Screen

(v Reinstall the printer driver.
[Windows] 1. Click Cancel.
2. When the Terminate Installation screen

N A is displayed, click OK.
r@ ' == . Click Exit, then remove the CD-ROM.

. Turn the printer and the computer off.
. Restart the computer.

. Carefully follow the procedures
described on the £asy Setup
Instructions and reinstall the driver.

3 Printer port will be detected. Please wait

e ek ime. This isplay il g out when detection’s

[o) NV, I -]

e portorconnect it ifiaed communication,cick

Cancel
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Print Quality is Poor or Contains Errors

Problem
Ink does not eject
properly/Printing is
Blurred/ Colors are
Wrong / White
Streaks appear /
Printed Ruled Lines
are Displaced

| Possible Cause
Ink tank is not seated
properly

\ Try This
Check that the ink tanks are firmly seated in the print head and reseat them if
necessary.

Print head nozzles
clogged

Print the nozzle check pattern to check for uneven ink output.

See "Printing the Nozzle Check Pattern" on page 26.

When a specific color is missing from the nozzle check pattern, clean the print
head.

If ink supply is uneven: See "Print Head Cleaning" on page 28.

Media not loaded with
the print-side up

Check that your paper is loaded with the correct print side facing up.

Note Follow the instructions packaged with your specialty media for

loading and handling.

Incorrect paper type

‘W
On the Main tab, confirm that the Media Type selected matches the paper
loaded.

In the Print dialog box, confirm that the Media Type selected matches the
paper loaded.

Print Quality not set
properly

Be sure to set the Print Quality setting to High for Windows or Fine for
Macintosh.

v

On the Main tab, click High for the Print Quality setting.

1. Select Manual in the Print Mode pull-down menu in the Print dialog box and
then click Details.

2. Click the Quality icon and then drag the Print Quality slide bar to the Fine
end.

Printed Paper Curls
or Ink Blots

Paper being used is
too thin

Use High Resolution Paper or Photo Paper Pro to print images that require a
lot of ink (i.e. pictures with intense colors or photographs).

Color Intensity setting
is too high

Reduce the Intensity setting in the printer driver and try printing again.

‘W

1. Open the Printer Properties dialog box.

2. On the Main tab, select Manual for Color Adjustment, and then click Set.
3. Drag the Intensity slide bar to adjust the intensity.

1. Open the Print dialog box.
2. In the Print Mode pull-down menu, select Manual and then click Details.
3. Click the Color icon, then drag the Intensity slide bar to set the intensity.

Paper feed roller is
dirty

Clean the paper feed roller.
See "Paper Does Not Feed Properly" on page 45.

Printed Surface is
Scratched

Inappropriate paper
type used

Check to see if the paper you are printing on is too thick or curled.
See "Print Media to Avoid" on page 4.

Note that smudging may occur at the top and bottom edges of the paper when
using Borderless Printing. Ensure that the paper you are using is compatible
with Borderless Printing.

W
See "Media Types Suitable for Borderless Printing" on page 21.

See "Media Types Suitable for Borderless Printing" on page 23.
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Troubleshooting Printer Hardware

Problem

Printer Does Not
Start or Printer
Stops During
Print Jobs

‘ Possible Cause ‘

Print head has
overheated due to
long periods of
continuous printing

Try This

Stop printing and turn the printer off for at least 15 minutes to allow the print head
to cool down.

The print head tends to overheat when printing continuously for long periods of
time. The print head is designed to automatically pause at line breaks before
resuming printing in order to cool down.

Caution The area around the print head can become extremely hot
during extended print operation. Always avoid touching the

print head and its peripheral components.

Printing high-
resolution
photographs and
graphics

Wait until the print job finishes.

The POWER lamp flashes green while the print data is being processed. Printing
photographs and high-density graphics can take time.

Printer cable is too
long

Avoid using USB cables longer than 16.4 feet.

There may be
problems in your
operating system

Restart your computer. It may solve the problem.

Delete an undesired print job if there is any. Use B) Status Monitor in Windows or
BJ Print Monitor in Macintosh for the deletion.

W

1. Open the Printer Properties dialog box.
See "Opening the Printer Properties Dialog Box Directly from the Start Menu"
on page 11.

2. Click Maintenance tab and then Start Status Monitor.
3. Click Display Print Queue.

4. Select Cancel All Documents in the Printer menu.
Click Yes when a confirmation message appears.
The print job is deleted.

Note  In Windows Me or Windows 98

Click to select an undesired document and select Purge Print
Documents in the Printer menu.

1. Double-click B) Print Monitor in the Extensions in the System Folder.

2. Click to select an undesired document and click [&].
The print job is deleted.

Cannot Print to
End of Job

Incorrect page size
selected

Verify that the page size setting matches the size of the paper loaded in the

printer:

- Check the Paper Size setting from within your application to ensure that it
matches the size of the paper loaded.

- Check the Page Setup tab in the Printer Properties dialog box (for Windows) or
the Page Setup dialog box (for Macintosh) to ensure that it matches the size of
the paper loaded.

Not enough free
space on hard disk

Your operating system may be out of free disk space.
Check the available space on your computer’s hard disk.
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Paper Does Not Feed Properly

Problem

Paper Does Not
Feed Properly

‘ Possible Cause ‘

Remove packaging
material

Make sure all packaging materials have been removed from the sheet feeder slot.
Open the printer cover and remove any materials inside the printer.

Try This

Paper jams

1.

. Close the front cover and reload the paper into the sheet feeder, then press the

Gently pull the jammed paper out of the sheet feeder slot or the paper output
slot, whichever is easier.

e If the paper tears and some of it is left in the printer, turn the printer off, then
open the front cover and remove the piece of paper. Do not touch internal
parts in the printer. If you cannot reach or remove the torn paper, do not
attempt to disassemble the printer yourself. Contact the Customer Care
Center.

¢ If you cannot extract the paper, turn the printer off, and then turn it back on.
The remaining paper will be ejected automatically.

RESUME/CANCEL button on the printer.

Paper feed roller
dirty

Follow the steps described below to clean the paper feed rollers.

W
. Ensure the Printer is on and there is no paper loaded in the printer.

. Open the Printer Properties dialog box.
. Click the Maintenance tab.

. Click Roller Cleaning.

. The confirmation message is displayed.

v B~ W N R

AN U~ W N R

. Ensure the Printer is on and there is no paper loaded in the printer.
. Open the Page Setup dialog box.

. Click Utilities....

. Select Cleaning from the pull-down menu.

. Click Roller Cleaning.

. The confirmation message is displayed.

Follow the instruction on the screen.

Follow the instruction on the screen.

Inappropriate paper
type

Check to see if the paper you are printing on is too thick (17 lbs to 28 lbs), or
curled.

See "Print Media to Avoid" on page 4.
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Handling Error Messages

When a printer error occurs, the POWER/ERROR lamp flashes. The number of
flashes indicates the type of error that has occurred. Count the flashes and
take the appropriate action to correct the error.

Green (lights =»
longer than orange) orange

Note the number
of flashes
1

Flashes =» Green (lights =»

Flashes
longer than orange) orange

) Repeats

Number of

Flashes
Two flashes

‘ Possible Cause ‘

Printer is out of
paper

Try This

Reload paper and press the RESUME/CANCEL button.

Three flashes

Paper jam

If a paper jam occurs, clear the jammed paper, reload paper in the printer, then
press the RESUME/CANCEL button. See "Paper jams" on page 45.

Four flashes

Ink tanks installed
incorrectly

Reinstall the ink tanks. Ensure that the tanks are firmly seated in the print head.

Five flashes

No print head
installed/Defective
print head

Install a print head correctly. If the problem still remains, contact a Canon service
representative.

Eight flashes

Waste ink tank
almost full

The printer has a built-in waste ink tank to hold the ink consumed during print
head cleaning.

Eight flashes indicates that this tank is nearly full.
Press the RESUME/CANCEL button to clear the error so printing can continue.
Contact the Customer Care Center.

An error that requires contacting the Customer Care Center may have occurred.

Disconnect the printer cable from the printer, and then turn the printer off and
unplug the printer from the power supply. Plug the printer back in and turn the
printer back on after leaving it about 10 minutes.

If the problem remains, contact the Customer Care Center.

Note POWER lamp flashes
alternately green and

orange
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An Error Message Appears on the Screen

Problem
o
Error Writing /
Output to USBxxx

| Possible Cause |

Printer not ready

Try This
The POWER lamp will flash green when the printer is warming up or when a print

job is being sent to the printer. It will glow a steady (non-flashing) green when it
is ready for use or when the print job is completed.

Paper is not loaded

Load paper and press the RESUME/CANCEL button.

Faulty connection

Ensure that the printer cable is securely connected to the computer.

Note If you are using a switching hub or other device, disconnect the
printer and reconnect it directly to the computer and try
printing again.

If successful, the problem may have been with the device.
There could also be a problem with the cable(s). Replace the

cable(s) and try printing again.

Printer port error

Verify the printer port status.

Double-click Universal Serial Bus (USB) controllers on the Device Manager
dialog box, then double-click Canon i350/Canon i250 to see the status.

Refer to the User's Guide for instructions on how to verify the status.

Printer port
settings and printer
interface do not
match

Confirm that the destination Printer Port is set to USB PRNnn (Canon i350/
Canon i250) or USBnn (Canon i350/Canon i250) (where nn represents a
number).

If the settings are not correct, follow the procedures described in the £asy Setup
Instructions and reinstall the printer driver.

Refer to the User’s Guide for instructions on how to verify status and the correct
action to take.

Printer driver is not
installed properly

Uninstall then reinstall the printer driver.

1. Click Start, and select All Programs (or Programs), Canon i350/Canon i250,
and Uninstall.

2. Follow the on-screen instructions to uninstall driver.

3. Follow the procedures described in the £asy Setup Instructions and reinstall
the printer driver.

“Error No.: X202”

Not enough
memory

Increase available memory by closing any other applications currently running.

“Error No.: X203”

Printer driver fault

Uninstall, then reinstall the printer driver.
Refer to the User’s Guidefor instructions on how to uninstall the printer driver.

“Error No.: X300”

Printer not ready

If the POWER lamp is off, turn the printer on.

If the POWER lamp is flashing green, the printer is initializing. Wait until the
POWER lamp stops flashing.

Printer not properly
connected

Ensure that the printer is securely connected to the computer.

Note If you are using a switching hub or other device, disconnect
the printer and reconnect it directly to the computer and try
printing again.

If successful, the problem may have been with the device.
There could also be a problem with the cable(s). Replace the

cable(s) and try printing again.

Printer not selected
in Chooser

1. From the Apple menu, select Chooser.

2. Click the i350/i250 icon and ensure that the i350/i250 is selected as the
target connection. If not, select it.

Note  Ifthe problem persists, delete all unnecessary documents

from the Extensions and Control Panels folder.
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Problem

“Have you replaced
ink tank with a new
one?” message
appears

| Possible Cause |
If the ink tank has
been replaced with
anewone

[ Windows |

Canon i350 - USBOO1

&\

The printer's front cover was opened after the last
printing. Have you replaced an ink tank with a new
The printer's frart cover was pened after the last printing. one?

Have you replaced anink tank with a new one?

TF you have replaced i, clck Yes.

TF you have nok replaced I or you are not sure, <lick No.

=% )

Ifyou have replaced it, click [OK]. If you have not
replaced it or you are not sure, click [Cancel].

ConeeD) 2]

Click Yes or OK to reset the ink counter.
See "Resetting the Ink Counter" on page 38.

If the front cover
has been open fora
certain period (the
ink tank has not
been replaced)

Click No or Cancel on the dialog box described above.
You can choose the option to disable the display of this confirmation message.

\\/
1. Ensure that the printer is on and open the Printer Properties dialog box.
2. On the Maintenance tab, click Low Ink Warning Setting.

3. Clear the check box on Display a confirmation message of Ink tank
replacement and click Send.

1. Ensure that the printer is on and open the Page Setup dialog box.
2. Click Utilities... to open the Printer Utility dialog box.

3. Select Remaining Ink level Setting from the pull-down menu and click Low
Ink Warning Setting.

4. Clear the check box on Display a confirmation message of Ink tank
replacement and click Send.

48




Troubleshooting

Problem

Low Ink Warning
Accompanied by Ink
Tank Icon With '?'

| Possible Cause |

Failure to reset ink
counter when
installing new ink
tank

Try This
The ink tank level accompanied by the ink tank icon with the “?” indicates ink
tank is not synchronized with its ink counter.

Canon 1350 Version dd

Docurnent Narne : Read Me

option Help

Printer Status

] The remaining level of the: following ink is
urkenain

If you wiart to 1eplace the ink tank. have the

ink tark number 24" reach.
Color

There s  possibilty that the printer cannot

detect the remaining ink level properly.

Reset the ink counler using the

Mainterance tab of the printer diiver v

Paper Thickness Lever Postion:  Left

Ouiner: defaut

Document Name: Dacumentdl
Prinfing Pages:  1/4

Cancel Printing | | Display Pint Queue

Always be sure to reset the ink counter in your printer driver when you replace
ink tank. See "Resetting the Ink Counter" on page 38.

Note If an ink tank is removed, “?” is displayed until you install a
new one and reset the ink counter. You can disable the
display by unchecking the Display low Ink Warning check
box.

‘W

1. Ensure that the printer is on and open the Printer Properties dialog box.
2. On the Maintenance tab, click Low Ink Warning Setting icon.

3. Clear the check box on Display low ink warning off and click Send.

1. Ensure that the printer is on and open the Page Setup dialog box.
2. Click Utilities... to open the Printer Utility dialog box.

3. Select Remaining ink level setting from the pull-down menu and click Low Ink
Warning Setting.

4. Clear the check box on Display low ink warning off and click Send.
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Appendix

Installing the Printer Driver when using Mac 0S 9.x

When using other than Mac 0S X (Mac OS 8.6 to 9.x), install the printer driver, following the
procedure below.

1 Turmon your Mac and insert the Setup Software & User’s Guide CD-ROM.

TURN THE PRINTER ON.

Open the Mac OS 8.6-9.x folder on the CD-ROM, then double—click the
Printer Driver folder.

Double-click the Installer icon in the Printer Driver folder.
Read the License Agreement and click Accept, if you agree.

Click Install.
The printer driver will load automatically.

If the message “No other applications can be running...” appears, click
Continue.

When the “Installation was successful” screen appears, click Restart.

From the Application folder, double-click on the software to be installed.
Follow the on-screen instructions.

When the “Installation has Finished” screen appears, click OK.

O OON O U P~W N

10 when prompted, restart your computer.
11 select the Apple menu, then Chooser.
12 Click the i350/i250 icon in the Chooser.

13 Close the Chooser.

Note Registeryour product at www.registercanon.com to ensure product
support.

14 To ensure highest quality output, continue with Step 7 Align the Print Head
on the £asy Setup Instructions.
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User’s Guide Table of Contents

Your printer's electronic User's Guide, located on the Setup Software and User’'s Guide CD-

ROM, offers detailed information on the following topics.

How to Use This Manual
Printer Parts and Their Function

Useful Printing Techniques
Printing with Borderless Printing (i350

Photo Paper Pro

Photo Paper Plus Glossy
Matte Photo Paper
Transparencies

T-Shirt Transfers

only) Checking the Status of the Printer

Reducing Noise from Images Taken with
Digital Camera

Achieving Vivid Reproduction of Images

BJ Status Monitor Functions
BJ Print Monitor

with Lots of Greens and Blues Troubleshooting

Printing with Color and Brightness
Automatically Optimized

Adjusting Print Quality

Smoothing the Rough Edges of Certain
Images

Automatically Resizing the Image to Fit
the Page

Resizing the Image by Selecting the
Scaling Ratio

Printing Multiple Pages on a Single Page

Enlarging a Document by Printing it on
Multiple Pages

Cannot Install Printer Driver
Print Quality is Poor

Printer Does Not Start or Stops During
Print Jobs

Paper Does Not Feed Properly or Paper
Jams

The POWER Lamp Flashes Orange

An Error Message is Displayed on the
Screen

Problems Unique to Windows
Problems Unique to the Macintosh

Printing Multiple Pages for Assembly into  Appendix

a Booklet
Printing on Both Sides of the Page

Printing Stamped Messages on
Documents (Windows)

Printing Background Images on
Documents (Windows)

Adding Illustrated Effect to Documents
Printing the Entire Image in Single Color
Printing in Grayscale

Reversing the Page Printing Order
Printing on Nonstandard Size Paper
Reducing the Sound of Printer Operation
Registering Printer Driver Settings

Printing Media
Compatible Media Types
Envelopes
High Resolution Paper
Glossy Photo Paper
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Printing Area

Using the Printer with a Network
(Macintosh Mac 0S 8.6-9.x)

Uninstalling the Printer Drivers
Uninstalling the User’s Guide
Transporting printer

Printer Driver Functions (Windows)
Printer Driver Functions (Macintosh)
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Specifications

Printer
Printing resolution:

Print speed *

*Print speed may vary with the content of the
document and the processing speed of the
host computer.

Print width:

Resident print control mode:
Receive buffer:
Interface:

Acoustic noise level:
Operating environment:
Storage environment:
Power supply:

Power consumption:

Dimensions

(with the paper rest and paper output tray retracted):

Weight:

Graphic image printing:

Print Head:

4800 X 1200 dpi. max.

(Ink droplets can be placed in a pitch of 1/4800 inch at minimum.)
Black printing

Max Speed (Custom Setting 5): 14 ppm (i350) / 10 ppm (i250)
Standard: 11 ppm (i350) / 8.1 ppm (i250)

Color printing

Max Speed (Custom Setting 5): 9 ppm (i350) / 8 ppm (i250)
Standard: 4 ppm (i350) / 3.5 ppm (i250)

203.2 mm max. (8.0 in)
(for Borderless Printing: 127 mm / 5.0 in)

Canon extended mode
32KB
usB

Ap%ro)x. 48 dB (A) / Approx. 46 dB (in the highest print quality
mode,

Temperature: 5 to 35°C (41 to 95°F)
Humidity: 10 to 90%RH (no condensation)

Temperature: 0 to 40°C (32 to 104°F)
Humidity: 5 to 95% RH (no condensation)

AC 100-127 V, 50/60 Hz
AC 220-240V, 50/60 Hz

Standby: Approx. 1 W
Printing: Approx. 14 W

385 (W) X 195 (D) X 165 (H) mm
15.15 (W) X 7.67 (D) X 6.49 (H) in

Approx. 2.4 kg (5.3 Ib.) (i350) / Approx. 2.3 kg (5.1 lb.) (i250)

Data format:

Canon extended mode: Raster image format
Resolution:

Canon extended mode: 300, 600, 1200, 4800 dpi
Black: 320 nozzles (600 dpi)
Cyan, Magenta, Yellow: 128 nozzles per each color (600 dpi)
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Printer

Ink Tanks: Capacity (pages):
Black (BCI-24 Black) approx. 300*2, approx. 520*2
Color (BCI-24 Color) approx. 170"2

*11500 characters per page, normal text, at standard and plain
paper mode with Windows XP printer driver

*2 Based on printing the ISO JIS-SCID No.5 pattern at standard and
plain paper mode with Windows XP printer driver

B) Printer Driver Systems Requirements

l“viv'm

® Use a computer equipped with Windows XP, Windows ® Use a Macintosh series computer equipped with USB
2000, Windows Me, Windows 98 can operate. interface on which Mac 0S 8.6-9.x or Mac 0S X v.10.2.1

® USB interface or later can operate.

® Available hard-disk space for printer driver installation ® Available hard-disk space for printer driver installation
Windows XP/Windows 2000: 50MB Mac OS 8.6-9.x: 30 MB
Windows Me/Windows 98/Windows 95: 15MB Mac 0S X v.10.2.1 or later: 100 MB

USB operation can only be guaranteed on a PC with pre- ® The following functions are not supported when using

installed Windows XP, Windows 2000, Windows Me, or Mac 0S Xv.10.2.1 or later:

Windows 98. (This includes Windows XP, Windows 2000, or - Duplex Printing

Wind)ows Me upgraded from pre-installed Windows 98 or - Photo Optimizer PRO

later]

Additional Systems Requirements for User's Guide

@ Pentium®, 75 MHz equivalent or higher processor (Pentium®, 133MHz equivalent or higher processor recommended )
® 2xor higher CD-ROM drive (4x or higher recommended)

® 20 MB of available hard-disk space

® Microsoft Internet Explorer 5.0 or later
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A Safety Precautions

Please read the safety warnings and cautions provided in this manual to ensure that you use
your printer safely. Do not attempt to use printer in any way not described in this manual.

Warning  You may cause an electric shock/fire or damage the printer if you ignore any of
these safety precautions.

Choosing a location

Do not place the printer close to flammable solvents such as alcohol or thinners.

Power supply

Never attempt to plug in or unplug the printer from the power supply when your hands are wet.

Always push the plug all the way into the power outlet.

Never damage, modify, stretch or excessively bend or twist the power cord.
Do not place heavy objects on the power cord.

Never plug the printer into a power socket that is shared with other
equipment (extension lead/cord, 2- or 3- way adapter, etc.).

Never use the printer if the power cord is bundled or knotted.

If you detect smoke, unusual smells or strange noises around the printer, immediately unplug the
printer at the power supply and call for service.

Periodically, unplug the printer and use a dry cloth to wipe off any dust or dirt
collected on the plug and the power outlet. If the printer is placed at a location
exposed to a lot of dust, smoke, or high humidity, the dust collected on the
plug absorbs moisture and may cause insulation failure and fire.

Cleaning the printer

Use a damp cloth to clean the printer. Never use flammable solvents such
as alcohol, benzene or thinners.

If flammable solvents come in contact with electrical components inside the
printer, it could cause a fire or electric shock.

Always unplug the printer from the power outlet before cleaning the printer.

If you accidentally switch the printer on while cleaning it, you could injure yourself or damage the
printer.

Maintaining the printer

Do not attempt to disassemble or modify the printer. There are no user serviceable parts inside
the printer.

The printer contains high-voltage components. Never attempt any maintenance procedure not
described in this guide.

Working around the
printer

Do not use flammable sprays near the printer.

This could cause a fire or electric shock if the spray comes into contact with electrical components
inside the printer.
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Caution You may cause injury or damage the printer if you ignore any of these safety
precautions.

Choosing a location

Do not install the printer in a location that is unstable or subject to excessive vibration.

Do not install the printer in locations that are very humid or dusty, in direct sunlight, outdoors, or
close to a heating source.

To avoid the risk of fire or electric shocks, install the printer in a location with an ambient
temperature range of 5°C to 35°C (41°F to 95°F) and humidity of 10% to 90% (condensation free).

Do not place the printer on a thick rug or carpet.

When moving the printer, carry the printer at both ends.

Power supply

Ensure that the area around the power outlet is kept clear at all times so you
can easily unplug the power cord if necessary.

Never remove the plug by pulling on the cord.

Do not use an extension lead/cord.

Never use a power supply source other than the one rated for the printer in the country where you
purchased the printer.

AC 100-127V, 50/60 Hz

AC 220-240V, 50/60 Hz

Working around the
printer

Never put your hands or fingers in the printer while it is printing.

Do not place metal objects (paper clips, staples, etc.) or containers of flammable solvents (alcohol,
thinners, etc.) on top of the printer.

If any foreign object (metal or liquid) fall into the printer, unplug the power cord and call for
service.

Print heads and ink tanks

For safety reasons store print heads and ink tanks out of the reach of small children.
If a child ingests any ink, consult a doctor immediately.

Do not shake print heads or ink tanks.
Ink may leak out and stain clothing or the surrounding area.

Never touch the electrical contacts on a print head after printing.
The metal parts may be very hot and could cause burns.
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Regulatory Information

Color Printer Model: K10228 (i350/i250)

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

e Reorient or relocate the receiving antenna.

¢ Increase the separation between the equipment and receiver.

¢ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

e Consult the dealer or an experienced radio/TV technician for help.

Use of a shielded cable is required to comply with Class B limits in Subpart B of Part 15 of the FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If such changes or
modifications should be made, you could be required to stop operation of the equipment.

Canon U.S.A,, Inc.

One Canon Plaza

Lake Success, NY 11042

1-516-328-5600

Canadian Radio Interference Regulations

This digital apparatus does not exceed Class B limits for radio noise emissions from a digital apparatus as set out in the
interference-causing equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry Canada.

Cet appareil numérique respecte les limites de bruits radio éléctiques applicables aux appareils numériques de Classe B
prescrites dans la norme sur le matériel brouilleur: “Appareils Numériques”, NMB-003 édictée par 'Industrie Canada.
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CANON LIMITED WARRANTY --- (USA Only)

The limited warranty set forth below is given by Canon U.S.A., Inc. (“Canon USA”) with respect to the new or refurbished
Canon-brand printer or scanner (each a “Product”) packaged with this limited warranty, when purchased and used in the
United States only.

The Product is warranted against defects in materials and workmanship under normal use and service (a) for a period of one
(1) year from the date of original purchase when delivered to you in new condition in its original container or (b) for 90 days
from the date of original purchase for refurbished Products. Defective parts or a defective Product returned to a Canon USA
repair facility or a Canon USA Authorized Service Facility (“ASF”), and proven to be defective upon inspection, will be repaired,
exchanged for new or comparable rebuilt parts, or exchanged for a refurbished Product, as determined by the Canon USA
repair Facility or the ASF. Warranty repair or replacement shall not extend the original warranty period of the Product. This
warranty does not cover any accessories, or any consumables, such as paper or ink cartridges, as to which there shall be no
warranty or replacement.

This limited warranty shall only apply if the Product is used in conjunction with compatible computer equipment and software.
Canon shall have no responsibility for such items except for compatible Canon brand peripheral equipment covered by a
separate warranty (“Separate Warranty”). Repairs of such Canon brand peripheral equipment shall be governed by the terms
of the Separate Warranty. Non-Canon brand equipment and software that may be distributed with the Product are sold “as is”
and without warranty of any kind by Canon USA, including any implied warranty regarding merchantability or fitness for a
particular purpose, and all such warranties are disclaimed. Tf!e sole warranty, if any, with respect to such non-Canon brand
items is given by the manufacturer or producer thereof.

This limited warranty covers all defects encountered in normal use of the Product and does not apply in the following cases:

(@  Loss of or damage to the Product due to abuse, neglect, mishandling, improper packaging by you, alteration, accident,
electrical current fluctuations, improper use, failure to follow operating or maintenance instructions, or environmental
conditions prescribed in Canon USA’s user’s manual or other documentation, or services performed by someone other
than a Canon USA repair facility or its ASF. Without limiting the foregoing, dropping the Product, scratches, and
abrasions will be presumed to have resulted from misuse, abuse or failure to operate the Product as set forth in the
operating instructions.

(b)  Use of parts or supplies (other than those sold by Canon USA) that cause damage to the Product or cause abnormally
frequent service calls or service problems.

(c) If the Product has had it serial number or dating defaced, altered or removed.

ANY SYSTEM SOFTWARE (WHETHER FACTORY LOADED ON THE PRODUCT OR CONTAINED ON THE SOFTWARE DISKETTES OR CD-
ROM'S ENCLOSED WITH, OR ACCOMPANYING, THE PRODUCT), AND ANY UTILITY SOFTWARE, DISTRIBUTED WITH OR FOR THE
PRODUCT, IS SOLD "AS IS" AND WITHOUT WARRANTY BY CANON. THE SOLE WARRANTY WITH RESPECT TO SUCH SOFTWARE IS
CONTAINED IN THE SOFTWARE MANUFACTURER'S LICENSE AGREEMENT DISTRIBUTED THEREWITH, INCLUDING ANY LIMITATIONS
AND DISCLAIMERS THEREON. PLEASE CONTACT CANON IMMEDIATELY IF YOU HAVE NOT RECEIVED A COPY OF THE SOFTWARE
MANUFACTURER'S LICENSE AGREEMENT.

NO IMPLIED WARRANTY, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE,
APPLIES TO THE PRODUCT AFTER THE APPLICABLE PERIOD OF THE EXPRESS LIMITED WARRANTY STATED ABOVE, AND NO OTHER
EXPRESS WARRANTY OR GUARANTY, EXCEPT AS MENTIONED ABOVE, GIVEN BY ANY PERSON OR ENTITY WITH RESPECT TO THE
PRODUCT SHALL BIND CANON USA, OR ITS ASF. (SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED
WARRANTY LASTS, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.) CANON USA SHALL NOT BE LIABLE FOR LOSS OF
REVENUES OR PROFITS, INCONVENIENCE, EXPENSE FOR SUBSTITUTE EQUIPMENT OR SERVICE, STORAGE CHARGES, LOSS OR
CORRUPTION OF DATA, OR ANY OTHER SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES CAUSED BY THE USE, MISUSE, OR
INABILITY TO USE THE PRODUCT REGARDLESS OF THE LEGAL THEORY ON WHICH THE CLAIM IS BASED, AND EVEN IF CANON USA
OR ITS ASF HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. NOR SHALL RECOVERY OF ANY KIND AGAINST CANON
USA OR ITS ASF BE GREATER IN AMOUNT THAN THE PURCHASE PRICE OF THE PRODUCT CAUSING THE ALLEGED DAMAGE.
WITHOUT LIMITING THE FOREGOING, YOU ASSUME ALL RISK AND LIABILITY FOR LOSS, DAMAGE OR INJURY TO YOU AND YOUR
PROPERTY AND TO OTHERS AND THEIR PROPERTY ARISING OUT OF THE POSSESSION, USE, MISUSE, OR INABILITY TO USE THE
PRODUCT SOLD BY CANON USA NOT CAUSED SOLELY AND DIRECTLY BY THE NEGLIGENCE OF CANON USA, OR ITS ASF. (SOME
STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE
EXCLUSION OR LIMITATION MAY NOT APPLY TO YOU.) THIS LIMITED WARRANTY SHALL NOT EXTEND TO ANYONE OTHER THAN THE
ORIGINAL PURCHASER OF THE PRODUCT OR THE PERSON FOR WHOM IT WAS PURCHASED AS A GIFT, AND STATES YOUR
EXCLUSIVE REMEDY.
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Canon offers a full range of customer technical support* options:

. For interactive troubleshooting, e-mail technical support, the latest driver downloads and answers to frequently asked
questions (www.canontechsupport.com)

Automated interactive telephone support on most current products 24 hours, 7 days a week (1-800-423-2366)
24-hour, Fax-On-Demand System for product specifications and technical information (1-800-526-4345)

Free live technical support Monday—Saturday (excluding holidays) for products still under warranty (1-757-413-2848)
The location of the ASF nearest you (1-800-423-2366, select "automated support options")

If the problem cannot be corrected by using one of the above technical support options, repair options are available at the time
of your call to the Free live technical support number above or via the website at www.canontechsupport.com

This limited warranty gives you specific legal rights, and you may also have other rights, which vary from state to state.
* Support program specifics are subject to change without notice.

Canon U.S.A,, Inc.

One Canon Plaza

Lake Success, NY 11042
USA

Canon is a registered trademark of Canon Inc.
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